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Quick Start Guide for IGSS FREE50

Introduction
This guide is intended to get you up and running with the 1GSS FREESO license as fast as possible. It provides
a quick route through the typical workflow:

For more detailed documentation of IGSS, please refer to the Getting Started manual and the IGSS help

files.
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STEP 1. Installing and updating IGSS

1) Right-click the IGSS installation download file, IGSS90_Full.zip, and select Extract All.

Open
Explore

Extract All.
Upen Withe.

Share..,

Restare previcus versions

Send To

2) Open the extracted folder and open the cdimage folder. Double-click the Setup.exe file.

= fE s
@TD.\ |+ Downloads » IGSS » 1GSS90_Full » cdimage » ~ [ 4| search 2|
Erra s Name B Date modified Type Size
E D — i FrameWorks 24-09-201014:12 File Folder
X . Hardlock 09-09-201011:53 File Folder
B pictures i 1655 24-00-201014:12  File Folder
Ji Downloads | InstallerUpd 24-00-201014:12  File Folder
Mare » l OPC 24-09-201014:12 File Folder
Folders v . VBAcore 24-09-201014:12 File Folder
& Recycle Bin o L VCredist 24-09-201014:12 File Folder
} Company L VSTO 24-09-2010 14:12 File Folder
} Downloads gsetup.exe 22-03-201011:30 Application 323 KB
1 1G5S
- 1G5590_Full
|. cdimage
. FrameWorks K
. Hardlock
|| 1655
.. InstallerUpd =
|| opc
. VBAcore
. VCredist
L VSTO
|| Tech Writer Workshop =2
, 9 items
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3) Click Yes to install IGSS. The IGSS V9.0 Installer Progress now appears.

165532 V9.0 Installer

Thiz inztaller will install IGS532 version 9.0 and all prerequisites needed.

the Contral Panel

Prerequisites are not uninztalled together with IGSS but can be individually
uninztalled in the Control Panel

Ewxcel 2007 or newerL\\,a prerequizite for IGSS advanced reporting

install Excel BEFORE |GSS

Do you want to install IG55327 Yes Mo

Prerequisites are installed az separate packages and will appear individually in

G55 do not install Excel go if advanced reporting iz required pou mugt manually

1G5532 V9.0 Prerequisite Installer Progress

f Prepare installation

s Microsoft MSI Engine 3.1

f Microsoft \NET Framework 3.5

f Microsoft C++ Runtime

= Microsoft Office PIAs

Microsoft VSTO

Microsoft VBA Engine Core Component
OPC core components

Hardlock Driver

1G5532 Version 9.0

Cancel |

4) Click Next when the Install Wizard opens.

120165532 V.9.0 Setup

Wizard

N

=& =

Welcome to the 1G5532 V.9.0 Setup

The Setup Wizard will install IGS532 V.59.0 on your computer,
Click Next to continue or Cancel to exit the Setup Wizard.

Back [ MNext

J

[ Cancel
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5)

6)

7)

Select the | accept the terms in the License Agreement check box and click Next.

IGSS requires a Pentinm 1 Ghz PC or equivalent running Windows
7. Windows 2008 server, Windows Vista, Windows 2003 Server,
Windows XP, Windows 2000 or Windows 2000 Server.

At least one free parallel or USB port on the server PC nmst be
available for the IGSS dongle for licensed systems.

Memory requirements are related to the size of the IGSS database,
screen resolution and concurrent use of other software packages. We
do recommend at least 256 MB RAM in addition to OS
requirements. =

m

[¥]1 accept the terms in the License Agreement

1) 165532 V.9.0 Setup N o] B =
End-User License Agreement \
Please read the following license agreement carefully sts

Print ] [ Back ][ Mext ] [ Cancel

Select the destination folder, and then click Next.

121165532 v.9.0 Setup
Destination Folder

Install IGS532 v.9.0 to:

|c: \Program Files\7T\IG553219.04

= =

(==
Click Next to install to the default folder or dick Change to choose another| ‘ sts

Back ][ MNext ] [ Cancel

Click Install. The installation process is now started.

4165532 V.9.0 Setup [ B ==
Ready to install 1685322 V.9.0 \ ,Gss
Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.
Back ][ Install ] [ Cancel
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1) 165532 V.9.0 Setup

Installing 1GSS32 V.9.0

Please wait while the Setup Wizard installs 1G5532 v.9.0.

Status:

8) Select the Type of Station.

Station Type ﬂ

’i IGSS  Station Type

—Select type of this station

Your selection can be ch i after i llztion in IGSS System Configuration

Users new to IGSS are advised to start as a Demo station

& Run the IGSS demo
" Runas a single user or server

" Runasan operator station

9) Select IGSS FREE50 and click Next.

e

Please Select the type of system to install @

% IGSS License

—Select type of system to install

" Demo System
& |GSS FREES0
" Licensed System

”Li:srss file (Options bed)

You selection can be change after installation
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10) Click Finish.

4165532 V.9.0 Setup

(=]lE =]

Completed the 1GS532 V.9.0 Setup
Wizard

Click the Finish button to exit the Setup Wizard.

N

Back Cancel

11) If you are connected to the internet, click Yes.

165532 - ==

1G55 installation has completed

Do you want run the G55 Update program to get the latest version of the IG55
software

(An internet connection is required)

N
Yes I MNe

12) Click Next.

1655 uma_ £ |

Tools b

Welcome

Welcome to the 1GSS Update program. Please close all 1GSS programs before updating. Click Mext
to continue. Click Cancel to exit this program.
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13) Select | agree and click Next.

1G55 Update = | (5] |

Tools

License Agreement
“You may continue with the upgrade f you are running the IG55 demo software on your PC, in which
case no Support and Update Agreement is required.  However, upgrading enduser installations
without a valid Support and Update Agreement is a breach of the System Integrator Agreement

@ |agree

() | disagree

[<Back | [ Net> | [ Cancel |

14) Click Select All to download all updates and click Next.

1GS5 Update (=] @ [
Tools L\\)

Updates available
Updates are available. Please select the files you want to update in the list below.

»

Filename Size Available version *Your version

Program files

|

TTACOM.I 1458 kB 10138 5260

TTACOMC dIl 1423kB 10138 9260

TTDHFILEdI 1468 kB 10138 5260

TTDHFILEc i 15.65kB 10138 5260

Ft2000.dI 2442kB 10138 5260

Fmod dil 1460 kB 10135 5260

Fmode dl 17.63kB 10135 5260

TTOMRTCP dl 11.88kB 10138 (New file)

TTOMRTCPC.dI 17.30kB 10138 (New file) -

Select All | Selected files: 46 (7.53 MB)

Mote: the list of updates is filtered. Change filtter settings in the configuration utility or Options menu.

Release notes [ < Back ] [ Nexd ] [ Cancel ]
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15) Click Finish.

%

1655 Update =(=h ==
Tools
Update process completed
Updates downloaded and installed.
Click Finish to exit this program.
Filename Size Available version *Your version |~
Program files E
TTACOMI 14,58 kB 10138 9260
TTACOMC Il 14,23 kB 10138 9260
TTOHFILEIl 14,68 kB 10138 5260
TTOHFILEc dI 15,65 kB 10138 9260
Tt 2000.dI 2442 kB 10138 9260
Ttmod.dil 14,60 kB 10139 9260
Tmode.dll 17.63kB 10139 9260
TTOMRTCP dil 11.88 kB 10138 (New file)
TTOMRTCPC Il 17.30kB 10138 (New file) -

16) Click Yes to reboot the PC and thus apply your installation settings.

55532

S

:_\ Setup has completed. Would you like to reboot now?

STEP 2.

1) Click Start > All Programs > IGSS 9.0 > IGSS.

@ Microsoft Web Platform Installer
[Z] Windows Calendar

[=] Windows Contacts

4 Windows Defender

B8 Windows Live Messenger Download
[s2) Windows Mail

[2] Windows Media Player

Windows Meeting Space G
B Windows Movie Maker

] Windows Update
Citrix
Games

Igss80 N
16559.0

Intel PROSet Wireless

Maintenance
Maxthon2

4 Back

ctures

Windows Photo Gallery Music
Accessories Recent ftems

Extras and Upgrades Computer

<) 1655 Connect To

MadCap Software Control Panel

Default Programs

Help and Support
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2) Click the application button and select Design Mode. On the Design and Setup ribbon, click the
Project Wizard button.

Home Design and Setup
A
a by W .

Project| Open Connect to New Sy
Wizard | Projedt  1GSS Server Confiy

ety

IStﬂius

3) Click Next.

Project Wizard @

| Welcome to the Project Wizard, which will guide you through the process of either creating a new IGSS project
[ or modifying the active project.

Click Next to continue.

Click Cancel to exit.

4) Select Create a new IGSS project.

Project Wizard @

What do you wart to do 7

(@ Create a new IGSS project

() Modify the cument project

<Back || MNed>
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5)

Give your project a name and specify a location

. Click Next.

Project Wizard

is the name of the project {do not specy any extension) 7

should the project files be stored 7

==

C:\IGSS Configs

[] Create a subfolder with the project name

< Back Next > Finish Cancel

6) Select the station type Single User a.k.a. Standalone and click Next.

Project Wizard

Statistics
Stations:
Drivers:
Top MNodes:
Sub Modes:

o o oo

Which station type do you want the PCto be 7

ingle User a k.a. Standalone

() Server

~) Server 1in a Dualized System
() Operator Station

") Operator Station, Distibuted Driver with/without Single User Backup

() Primary Serverin an A/B Switch System (Legacy)
() Operator Station, Server Backup (Legacy)

Add an Operator Station

Addan O

perator Station, Distibuted Driver with/without Single User Backup

Add an Operator Station, Server Backup (Legacy)

Legacy station types are still supported to maintain backward compatibility with earier 1555 versions, but should
not be used when setting up new projects.

« Back Nes inish Cancel
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Do the following:

a) Start by clicking the New Driver button and select the relevant driver from the list.
b) Click New Interface to specify the connection type (COM port, modem or radio).
c) Click New Node for each PLC you want to set up.

A node in IGSS corresponds to a physical PLC.

e Software and hardware requirements for all PLC drivers supported by IGSS are described on the
IGSS website at this address: http://www.igss.com/overview/PLC-drivers-supported.aspx.

Project Wizard =3
Unigue name for the station:
Demo Station

Dirivers for the station must be set up. This is done below.
Driver configuration
List of drivers List of interfaces List of nodes

Siemens 57 protocal driver Channel 0 (POLLED' MNode O
Node 1

Statistics

Stations: 1

= e Delete Interface | | Delete Node |
Sub Modes: 1]

NOTE: The selected driver can only have one interface

| <Back | MNea> || Finsh | | Cancel
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7) The initial setup is now completed. Click the Finish button.

Page 12 of 24

Project Wizard

i

Statistics
Stations:
Drivers:
Top Modes:
Sub MNodes:

oW =

Your setup work is now complete.

Click: Finigh to end this wizard and save.

Click Cancel to ext.

[

Finish

] [ Cancel ]

8) Select the DemoStation in the tree view. The screen of the computer icon should turn green. If
not, right-click the icon and select This PC in the popup menu.

L. IGSS - System Configuration c\igss confir

File Edit View Tools Help

E 2= Ea . V4
Project name: freeS0 s
- 5 T

-l TTS7

[ Nedeo
Model
MNode 2

- 82 Siemens 57 protocol driver
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9) Select the Data Collection tab.
e If you want to communicate with a real PLC, make sure that Run simulated is NOT selected.

| Station I Corfiguration I Files I Access Control | Alam I Supervise & Languagel Startup | Data Collection | Reports

[ Run simulated
[T Start with extended logging
[] Dual cmd on 8 bit dig
[T Ack old alarms at startup
[7] Ack alam to PLC with command bits L\\’
[ End alam when PLC ACK ends
[] Mark objects with System Reset on Driver emors
[ Ignore address faults
Validate input values against range
|| Server is backup for distributed drivers
Alamms to Driver object

= Only if no Node Status object defined
= or ff node number unknown

@ Aways

Alarms to Node Status object

10) In the File menu, click Save and Exit.

L IG55 - Systern Configuration C:\Pragr
Edit View Tools Help

Sawve Configuration Ctrl+3

Sawe and Ext

Exit
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STEP 3 Creating a process diagram in the Design module, Definition

1) In the IGSS Master module, select the Design and Setup tab, then click the Definition icon.
2) Inthe Area menu, select Create.
3) Define an area name — do NOT use spaces in the name.

E;":] 1655 Definition [CAIGS5 Configs\FREESOVFREESD.elm] *
File Edit View Format Area Diagram Graph Template Objects UserPrograms Tools  Views Window

HELE +E288 @ W NNZoBEENIEY

Name [FREES0

g DESCTiPtON /

Default Node 1} Name to Menu

Default Driver

Protection :

User defined entries for command menu

Use pipe () to delimit multiple menu entries

Use semicolon (;)to delimit multiple commands

Prefix poc] to display w00 in the command menu othenwise text up till first space is used
In parameter list 30 will be substituted with object name and $A with area

4) In the Diagram menu, select Create.
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5) Define a diagram name and select the check boxes as shown below.

Diagram Properties @
| Defintion of Diagram | Function Key Assignment
Neme  REE50_DIAGRAM Diagram Type
" - @ Standard diagram
Description _
(") Reusable diagram
Window Properties Control group:
Caption
@ Name () Description il SO
Background
Title bar MName to menu
System menu [ Keep window
Minimize [ Function keys
Maximize Status bar
[T Pinable [ To portal

[ Keep aspect ratio [ Popup
Flacement in Pixels

ek D Top 0 @) Picture Bro

Widh 1432 Height 585 @ Color

Protection : (Unused) -

- Controlling Object ...

Create... Edit... Delete...

Background Preview

Define Views

User defined ertries for command menu

Use pipe {j to delimit multiple menu entries

Use semicolon () to delimit multiple commands

Prefix food] to display oo in the command menu otherwise text up till first space is used
In parameter list 50 will be substituted with object name and $A with area

OK [ Cancel |[ Heb
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STEP 4 Creating your first process component

1) Click Objects -> Create -> By Using Object Wizard.

Objects | UserPrograms Tools Window Help

Create 4 By Using Object Wizard...

Edit Properties... Alt+Enter By Object Type 4
Delete By Display Type 3
Rectangular Field... Ctrl+1 By Symbel '
Command Field... Cirle2 By Standard Descriptors 3
Bar Display... Ctrl+3

Circular Display... Ctrl+4

2) Select the Analog option, enter an object name and click Next.

Object Wizard - Selection of object type

_ Which type of object do you want to create 7
"

FiY 01001 ) Digtal
| 12312 ) Courter

% I Table

text | () String

What should the object be named ?

Analog_flow

What is the description of the object ? {optional)

<Back || Ned> | [ Fnsh | [ Cancel
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3)

4)

Now it is time to set up the PLC addresses of the individual atoms (I/O points).
By default, the Actual Value, Set Point, High Alarm and Low Alarm are enabled.

Page 17 of 24

e Asan example, we’ve selected the Actual Value atom. To specify its PLC address, start by

clicking the Driver specific addressing button. Then enter the specific address.

e Repeat this procedure for the remaining atoms.

L

%

=
An atom is a single /O

point ortag which can be
set up for an object

1
Object Wizard - Step 1 of 6 - Analog_flow ‘Al
_ Which atoms and driver should be set up for this object 7
Task 1: Select atoms Task 2: Select driver
Atom Driver
[lHigh Alam +|  Dwver 3757 DemoStation +
[]High Limit
M Actual Value = Node 0 -
[w]Set Poirt
[JLow Limit Task 3: For each atom being sent
[v]Low Alarm out to or being received from the
[Alam-in ~ | PLC. a specific address must be
keyed in. »
1/0 mode for P
selected atom n M Click the button below
Driver specific addressing
<Back || MNew> | [ Fnish | [ Cancel

Driver Specific Addressing

Data Area DE [Data Block) -

DE number 1 =
Adressing S
Offset 0 =| Bit 0}
Simatic Mnenonic: DE1.DEWD
Bit Offset il =

External type FP165 -

7

Define the alarm limit values and corresponding alarm texts. To create an alarm text, click in the

Alarm Text column and select New alarm text.

Object Wizard - Step 2 of 6 - Analog_flow L2 TN New Alarm Text =5
_ Define a range of measuremert for the obiect: “what should the alarm number be ?
Vit should the maximum value be 7 100 0
Vit should the mirimum valus be ? 0

Each alam atom in the list below must be bound to an alam text

Wihat should the alarm pricrity be 7

“wihat should the alarm text be ?

Mam Az Text Value
High Alam {unspectied) 9000.000000 High alam exceeded
Low Al {unspecfied 1000000000
. i
Click on (unspecified) to select a text or to create a new one. \

Esch alsm stom must also be associated with an alam limit under Valus. Left click on the
defautt numberto key in a new number,

What should the actual value be 7 S
What should the setpoint be 7 @
<Back | Nea> | [ Fnsh | [ Cancel
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5) Select the relevant scan interval for the process component (IGSS object). How often do you want
to read the process value from the PLC?

Object Wizard - Step 3 of & - Analogflow [&J

How often should this object be scanned for changes ?

Mo scanning

@ Every 2000 miliseconds

~) Every 5000 miliseconds
Every 10000 miliseconds
Every 30000 miliseconds

| <Back | MNedt> | [ Fnmsh | [ Cancel |

6) Select the relevant data reductions and intervals. The data reduction values can be viewed in IGSS
graphs and form the data basis of IGSS standard reports.

r -
Cbject Wizard - Step 4 of 6 - Analog_flow Lé,l
_ Task 1: What should the time interval between data reduction be for the object 7
Mo data reduction
L]
l 2 minutes
B minutes

@) 10 minutes
30 minutes

Task 2: Which data reduction method do you want to use #
Transfer to histony

[Difference

Enable the above

<Back || Ne¢> | | Fnsh | [ Cancel
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7) Select what data you want to record in the IGSS LOG files. In this case, all changes are registered
including outgoing commands issued by the operator. The LOG data can be viewed in IGSS graphs.

Object Wizard - Step 5 of 6 - Analogflow

E2)

_ How should changes in object value be logged 7

Mo logging

@) All changes

LOG

Al values

Log only changes above 1%

Log only changes above 2 %

Log only changes above 5 %

Log only changes above 10 %
| Log outgoing commands

Options

| Uze the following:

Log to SQL database

V| Log to printer

[ <Back |[ Ned> | [ Finsh | [ Cancel |

8) Specify how you want to display the object and its process values on the diagram.

Object Wizard - Step 6 of 6 - Analog_flow Li_:h
_ How should the object be displayed on the mimic ?
/| Show the object’s name
q12 /| Show the object’s state/value
5500 m3mr  Pa1Z g
W r—) Off  Which color do you want to use on the symbol ? I -

Which symbel table and which symbol do you Analog elemerts

b |

want to use 7

&) (&) GO

[Measurer Logger DC-kat

Rotate symbaol J degree

Click Finish to complete the creation of this object. Click Cancel to exit.
Click Show Properties to complete and then show all properties for this object for
advanced users).

| < Back |[ Finish ]|Show Properties“ Cancel
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9) Click Finish and the analog object appears on the mimic diagram.

File Edit View Format Area Diagram Graph Template Objects User Programs Tools Views Window Help
N"NAZCEDESY»GEE - & «mOq

HER sBaR @ K|

10) In the Format menu, select Set Initial Display to set this diagram as the startup picture.

File Edit View [Format| Ares Diagram Graph Template O
Font...

Transparent Text
Set Colors...
Set Background Color

Set Initial Display

Multi-5creen Setup...
Set Grid Size...
Snap to Grid

Align
Make Same Size

Ering to Front
Send to Back

Group With Symbol
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11) Click File and select Check and Install.

12 1GSS Definttion [C:\IGSS Configs\FREESONFREESD.elm] ™
Edit View Format Area Diagram Graph Templaste Objects UserPrograms Tools Views

Revert cuq | K2 NNZoBI
Save Ctrl+S

Check and Install... Ctrl+T

Object Browser...
Import...

Re-Import...

Export..

Page Setup...

Print Preview »

Print 3

Exit

12) The Installation Options dialog box appears. Click OK.

Installation Options -7 |[=E3a]
Inztallation zettings Inztallation repart settings

Do nat report erors on missing pictures Sort objects by PLC address

Do nat report driver setup emors Sort objects by alarm number

Do not generate repart Sart objects by object bpe

Do NOT ingtall - show only report Show detailed object information

Ihchude theze object tppes
Area Tatle
Diagram Counter
Graph String
Analog Scale
Drigital Template
Skip this dialog Ok | | Cencel | [ Hep
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13) An installation status message appears. Click No.
If you click Yes, you will see a detailed report for the project.

Chelm [ & |

"-.I Installation completed with no errors,

-2 objects in configuration.

Do you want to view detailed information available in the file
= chigssconfigs\freed0\free50.PRT =,

NOTE: As you can see, there are already 22 objects in the project. This is because IGSS comes with a
number of predefined objects for different system purposes. The predefined objects are included for free,
that is, an IGSS license will include extra 15 objects. For example, the IGSS FREESO0 license includes 65
objects. Click here to read more about “Objects in IGSS”.

Calculating the number of objects in a project
The number of objects is calculated as follows:

e One object is counted for every new object you create
e One object is counted for every new template you create
e One object is counted when you name the states or commands in a digital template
(yet another object is counted if the template includes more than 25 states/commands)
e One object is counted for every time you use the valid commands feature in a digital template
e One object is counted when you define global function keys
e One object is counted for each diagram where you define function keys

You can always see the number of objects you've purchased and the number of objects currently used in
the project. Simply choose "Help About".

[ About 1655 @‘
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STEP 5. Running the project

1) Inthe IGSS Master module, under the Home tab, click the Start button.

D |
Home | DesignandSetup  Runfime:
e@% % o p
Start | Stop Restart Supervise | Alarm Dasﬂna
J[—M_ |-
stntp Start Full System L
Starts data collection and/or
Sys|  connect tothe IGSS server.
Once data callection has been 11| | D€
started or connection with the det
PLC|  server has beenestablished,
all the utility applications wil
be started.

g

2) The startup diagram appears in the Supervise module. The alarm icon appears immediately when
you start up. In this case, there are no alarms. When alarms occur, the color of the alarm icon

changes to the color of the most critical alarm. Double-click the alarm icon to view the active
alarms.

=l
x| &=t

Congratulations! You have created your first IGSS project and brought it online.
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Help and Support
7T hopes that the IGSS FREE5SO0 license will give you a good picture of the capabilities of the IGSS SCADA
system.

We recommend that you explore the Getting Started manual and the comprehensive 1GSS help system for

further details.

Should you have technical questions, limited e-mail support is available. Send an e-mail to Technical
Support at support@igss.com with the text “IGSS FREE50” in the Subject field.

If you have sales-related questions, do not hesitate to contact the sales manager for your region.
Read the contact information for the IGSS Sales Department here.
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